## Contents

1. **What format lexicon data can Lexique Pro display?** ........................................3  
   1.1. What are the field markers? ........................................................................... 3  

2. **How can I view my lexicon in Lexique Pro?** .............................................5  

3. **How can I configure my lexicon?** .................................................................6  
   3.1. Language Name .......................................................................................... 6  
   3.2. Encoding ..................................................................................................... 7  
   3.3. Gloss Languages ....................................................................................... 7  
   3.4. Gloss Language Details ............................................................................. 7  
   3.5. Field Markers ............................................................................................ 7  
   3.6. Paradigm Markers ..................................................................................... 7  
   3.7. Fonts ......................................................................................................... 8  
   3.8. Font Styles ................................................................................................ 8  
   3.9. Field Display ............................................................................................. 8  
   3.10. Upper and Lower Case ............................................................................ 9  
   3.11. Sort Order ................................................................................................ 9  
   3.12. Home Page ............................................................................................... 10  
   3.13. Label Translations ................................................................................... 10  
   3.14. Categories ............................................................................................... 10  
   3.15. Consistent Changes ................................................................................ 10  
   3.16. Omit Rules ............................................................................................... 10  
   3.17. About Language ..................................................................................... 10  
   3.18. Shortcuts .................................................................................................. 11  
   3.19. Open Lexicon .......................................................................................... 11  

4. **How can I distribute my lexicon to others?** .............................................12  

5. **Frequently Asked Questions** .......................................................................13  
   5.1. Where does Lexique Pro get the words from to build the English index? ...... 13  
   5.2. What are 'paradigm' fields? ........................................................................ 13  
   5.3. What are 'lexical function' fields? ............................................................... 14  
   5.4. I have homonyms in my database. When Lexique Pro creates hyperlinks from  
        other entries, how does it decide which of the homonyms to link to? .......... 16  
   5.5. I have a couple of words which are homonyms. How can I put a link in each of  
        these entries to go to the other homonym? .............................................. 16  
   5.6. The setup program I generate for my lexicon with the Distribution wizard: can  
        I give this freely to anyone? ................................................................. 17  
   5.7. Can I put the distributable setup program on my website for people to  
        download? ............................................................................................... 17  
   5.8. How can I get Lexique Pro to play my sound files? .................................... 18  
   5.9. My .pcx images are not displayed. Why is this? ....................................... 18  
   5.10. How can I include video files in a lexical entry? ....................................... 19  
   5.11. How can I include links to Word or PDF documents in a lexical entry? ...... 19  
   5.12. Are there Linux or Mac versions of Lexique Pro? ..................................... 20
1. What format lexicon data can Lexique Pro display?

Lexique Pro can read and display a lexicon database if it is a text file with recognised standard format markers, e.g.

\lx abada
\ps adv
\ge never
\gn jamais

\lx jakuma
\ps n
\ge cat
\gn chat

Different markers are used to indicate part of speech, definition, lexical function, synonym, variant forms, examples, morphology, subentries, cross references, etc.

This is the type of data file generated by the following two programs:

- The Field Linguist's Toolbox
- The Linguist's Shoebox

Both are available at http://www.sil.org/computing.

1.1. What are the field markers?

By default, Lexique Pro assumes that you are using field markers according to the Multi-Dictionary Formatter (MDF) standards. For example:

<table>
<thead>
<tr>
<th>lx</th>
<th>lexeme</th>
</tr>
</thead>
<tbody>
<tr>
<td>ps</td>
<td>part of speech</td>
</tr>
<tr>
<td>ge</td>
<td>gloss (English)</td>
</tr>
<tr>
<td>gn</td>
<td>gloss (national language)</td>
</tr>
<tr>
<td>de</td>
<td>description (English)</td>
</tr>
<tr>
<td>dn</td>
<td>description (national language)</td>
</tr>
<tr>
<td>re</td>
<td>reversal (English)</td>
</tr>
<tr>
<td>rn</td>
<td>reversal (national language)</td>
</tr>
<tr>
<td>xv</td>
<td>example</td>
</tr>
<tr>
<td>xe</td>
<td>example gloss (English)</td>
</tr>
<tr>
<td>xn</td>
<td>example gloss (national language)</td>
</tr>
<tr>
<td>rf</td>
<td>example reference</td>
</tr>
<tr>
<td>lf</td>
<td>lexical function</td>
</tr>
<tr>
<td>le</td>
<td>lexical function gloss (English)</td>
</tr>
<tr>
<td>ln</td>
<td>lexical function gloss (national language)</td>
</tr>
<tr>
<td>bw</td>
<td>borrowed word</td>
</tr>
</tbody>
</table>

| sf | sound file for pronunciation of lexeme (.wav or .mp3 file) |
| sfx | sound file associated with corresponding example, paradigm, or lexical function. (.wav or .mp3) |
| mr | morphology              |
| sy | synonym                  |
| an | antonym                  |
| sd | semantic domain          |
| is | index of semantics       |
| cf | cross reference           |
| ce | cross reference gloss (English) |
| cn | cross reference gloss (national language) |
| mn | main cross reference      |
| va | variant form             |
For more information about MDF with full descriptions of the kind of data expected in each field, see the following website:


From this website you can download the MDF description manual, *Making Dictionaries*.

If the markers you have chosen to use are not the same as in MDF, you will need to change the settings on the Field Markers page of the Configure Lexicon Wizard.
2. How can I view my lexicon in Lexique Pro?

To view a lexicon in Lexique Pro:

1. On the Lexique Pro main menu, select **File > Open**...

2. In the Open Lexicon dialog, select your lexicon database file (this normally has the extension .db) and click **Open**.

3. If this is first time you have opened the lexicon in Lexique Pro, the Configure Lexicon Wizard will appear.

4. Follow the instructions on each page of the wizard to configure your lexicon.
3. How can I configure my lexicon?

When you open a database for the first time in Lexique Pro, you will be taken through the pages of the Configure Lexicon wizard.

If you want to make changes to an existing configuration, you can choose between:

- Using the configuration wizard (Tools > Configure using wizard…) – where you step through each of the configuration pages.
- Using the configuration tabbed dialog box (Tools > Configure…) – where you can go straight to the page you are interested in.

Below are some notes on each of the configuration pages:

3.1. Language Name

Enter the name of the lexicon language. This will be the main title of the lexicon.

The SIL ethnologue and ISO 639 codes are not used at present so can be ignored if you do not use them.

![Configure Lexicon screenshot]

Use the **Advanced** tab if you want to enter a translation of the language name in French and/or Spanish which will be displayed when the interface is in French or Spanish.
3.2. Encoding

Lexique Pro needs to know whether your database is a plain ANSI file or a UTF-8 encoded file.
- If you use Shoebox to edit your data, select Plain text file.
- If you use Toolbox to edit your data but without using Unicode characters, select Plain text file.
- If you use Toolbox to edit your data and you use Unicode characters, select Unicode UTF-8 file.

3.3. Gloss Languages

Select which gloss languages you use in your lexicon, and the order in which they will appear.

If one of your languages does not appear on the screen, you can add it by clicking the 'Other...' button.

3.4. Gloss Language Details

For each gloss language, specify:
- which character is used in the field marker.
- whether you want an index created and displayed (to create this, Lexique Pro will do a dictionary reversal.)
- whether you want the language name displayed as a caption every time a gloss is displayed. (This is useful for gloss languages which are rare in the lexicon – not those which are present for every entry.)

3.5. Field Markers

If you have a MDF-format dictionary, you do not need to change anything here. Otherwise if you have used different markers than the standard, you can change them.

3.6. Paradigm Markers

A paradigm field contains a different grammatical form of the head word, for example: singular, plural, 1st person singular, 2nd person plural, diminutive, indefinite, etc.

Some of these are already defined in MDF such as singular (\sg) and plural (\pl). If the database contains other paradigm markers, you can define them on the 'Paradigm Markers' page. This is useful if your database contains markers such as:

\dim (Diminutive form)
\defpl (Definite plural)
\indpl (Indefinite plural)
3.7. Fonts

Specify default font names for each language.

The first time you attempt to configure your lexicon in Lexique Pro, these default to your Shoebox/Toolbox settings if they can be found.

You have the option of converting your data to Unicode if you have a compiled TECkit mapping file.

3.8. Font Styles

Here you can change the fonts used to display the data in various areas of Lexique Pro.

3.9. Field Display

Where applicable, you can configure the display of:

- **Part of Speech**: whether to change to upper or lower case.
- **Scientific Name**: whether to include a hyperlink to do a search on the web using Google.
- **Phonetic Form**: what kind of brackets to use around the text, and whether the text direction is Right-to-Left (e.g. for Hebrew or Arabic).
- **Example Reference**: what kind of brackets to use around the text, and whether the reference field marker appears before its associated example markers or after.
• **Multi-Entry view**: Which fields to display in multiple entry displays (e.g. when clicking on a letter button on the right of the screen, or when displaying category lists).

### 3.10. Upper and Lower Case

Specify upper, lower case and case associations. Characters should have spaces between them.

The first time you attempt to configure your lexicon in Lexique Pro, these default to your Shoebox/Toolbox settings if they can be found.

### 3.11. Sort Order

Specify the sort order and ignore characters. Characters on the same line should have spaces between them.

The first time you attempt to configure your lexicon in Lexique Pro, the sort order defaults to your Shoebox/Toolbox settings if they can be found.

If you want Lexique Pro to display a 'Sort from End' tab, select 'Display an extra tab with entries sorted from the ends of words'.
3.12. Home Page

Specify here the letters and images to be displayed on the home page, and also the letter to be included on the vertical button bar on the right side of the screen.

If no entries are found for a letter, the corresponding hyperlink and button will be disabled.

3.13. Label Translations

(This page is displayed only if you have \lf or \pd fields.)

3.14. Categories

(This page is displayed only if you have \sd or \is fields.)

There are two types of categories:
- those defined by \sd semantic domain fields, e.g. \sd Nhome, \sd Nfamily
- those defined by semantic indexes \is, following Ron Moe’s Dictionary Development Program (DDP).

Note: For the DDP, Lexique Pro reads its semantic codes and display names from the file: C:\Program Files\SIL\Lexique Pro\Semantic Domains\xdict3.db

3.15. Consistent Changes

Lexique Pro can use the SIL Consistent Changes utility (cc) to apply search and replace changes to your data before it is displayed. The changes will occur in memory only; the database file itself is not modified.

If required, specify the changes table (.cct) file to use.

3.16. Omit Rules

Here you can choose to omit fields matching certain criteria.

3.17. About Language

You can specify your own set of HTML pages here to be displayed when the user clicks on the About Language’ button on the toolbar.

You could, for example, include:
- maps
- linguistic summaries
- acknowledgements
- references
- links to documents and web pages, etc.
3.18. Shortcuts

Choose whether or not to create shortcuts on the Windows Desktop or Quick Launch bar.

3.19. Open Lexicon

Click Open, and Lexique Pro will attempt to load and display your database.

If you need to change any configuration settings, from the main menu select **Tools** > **Configure**.
4. How can I distribute my lexicon to others?

To package your lexicon and distribute it to others, go to Tools > Distribute Lexicon and follow the instructions in the wizard.

You are given permission to use and freely distribute Lexique Pro with your lexicon data, provided that:

- you are the owner of the lexicon data or have been given permission to distribute it;
- you do not distribute any of the Lexique Pro program files separately; they must be packaged in the setup program with your data, as created by the Distribute Lexicon Wizard;
- you do not use Lexique Pro to distribute offensive material;
- you make it clear to users how they can contact you for support. Since Lexique Pro is a freeware product, we are not able to provide support for everybody you give your data to.
5. Frequently Asked Questions

5.1. Where does Lexique Pro get the words from to build the English index?

1. If the entry contains no \re reversal fields, Lexique Pro takes the English straight from the gloss field (normally \ge). e.g.

\lx bileman
\ps adj
\ge red ; brown
\de red or brown in colour

--->
"red" and "brown" appear in the English list

2. If the entry contains a reversal field \re, Lexique Pro uses this data rather than the gloss field. e.g.

\lx bilen
\ps v
\ge to make red ; redden
\re red, to make ; redden

--->
"red, to make" and "redden" appear in the English list.

3. If the reversal field contains an asterisk, \re *, the entry is not included in the reversal.

\lx abikili
\ps n
\ge type of fish
\re *

--->
this entry does not appear in the English list.

For more information about the relation between gloss, definition and reversal fields in MDF, see the document Making Dictionaries (available from http://www.sil.org/computing/shoebox/MDF.html).

5.2. What are 'paradigm' fields?

Paradigm fields contain different forms of the main lexical entry word, normally sharing the same root or stem. A common example of such a field is the plural form of the noun, marked with \pl, e.g.

\lx mouse
\ps n
\pl mice
\de small rodent

\pl is an example of a standard paradigm field. The marker is defined in the MDF dictionary standards. Fields supported by Lexique Pro include:
If the paradigm field you want is not included in MDF (e.g. 'Accusative', 'Diminutive', 'Nominative Plural'), Lexique Pro supports two possible solutions:

1. Go to the Markers page of the Configure Lexicon wizard and select the User-Defined Markers tab. Click the 'Add Marker' button and enter the details of your field - the marker (e.g. \dim) and the label (e.g. 'Diminutive').

This will allow you to have fields in your database such as:

\lx abiki
\ps n
\acsg abikili [Accusative singular]
\acpl abikika [Accusative plural]
\dim abikinin [Diminutive]
\ge dog

2. Use the built-in multi-purpose \pdl (Paradigm label) and \pdv (Paradigm form) fields, e.g.

\lx abiki
\ps n
\pdl Acc. Sg
\pdv abikili
\pdl Dim
\pdv abikinin
\ge dog

The first of these solutions is clearly the neater of the two, but the second might be useful if you don’t have many occurrences of a paradigm.

5.3. What are 'lexical function' fields?

Lexical Function fields enable you to link from an entry to lexically-related entries in your dictionary. Two standard lexical function fields are provided in MDF:

\sy Synonym
\an Antonym

For other lexical functions, use the following set of multi-purpose markers:

\lf Lexical function
\lv Lexical function word
\le English gloss
National language gloss

Two formats are supported:

1. Put both the lexical function label and word in the \lf field, separated by a '=' , e.g.

   \lx kònò
   \ps n
   \ge bird
   \gn oiseau
   \lf Part = jolo
   \le feather
   \ln plume

2. Put the lexical function label in the \lf field, and the word in the \lv field, e.g.

   \lx kònò
   \ps n
   \ge bird
   \gn oiseau
   \lf Part
   \lv jolo
   \le feather
   \ln plume

In the above example, we have used the lexical function 'Part' to provide a link to 'feather' which is a part of the headword 'bird'.

For a detailed list of suggested lexical functions, see Chapter 7 'Relating headwords to their lexical networks' (pages 121-135) and Appendix D (pages 193-194) of Making Dictionaries. Here is a summary:

<table>
<thead>
<tr>
<th>Syn</th>
<th>Synonym</th>
<th>Compound</th>
<th>Lexicalised compound</th>
</tr>
</thead>
<tbody>
<tr>
<td>SynD</td>
<td>Dialectal synonym</td>
<td>Sit</td>
<td>Situation</td>
</tr>
<tr>
<td>SynL</td>
<td>Loan Synonym</td>
<td>Prep</td>
<td>Prepatory activity</td>
</tr>
<tr>
<td>SynR</td>
<td>Register Synonym</td>
<td>Phase</td>
<td>Phases of head</td>
</tr>
<tr>
<td>SynT</td>
<td>Taboo Synonym</td>
<td>Max</td>
<td>Superlative degree</td>
</tr>
<tr>
<td>Gen</td>
<td>Generic (hyperonym)</td>
<td>Min</td>
<td>Reduced/diminished degree</td>
</tr>
<tr>
<td>Spec</td>
<td>Specific (hyponym)</td>
<td>Degrad</td>
<td>Degradatory degree</td>
</tr>
<tr>
<td>Sim</td>
<td>Similar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nact</td>
<td>Actor noun</td>
<td>Start</td>
<td>Inceptive</td>
</tr>
<tr>
<td>Nug</td>
<td>Undergoer noun</td>
<td>Stop</td>
<td>Cessative</td>
</tr>
<tr>
<td>Nloc</td>
<td>Noun of location</td>
<td>Feel</td>
<td>Sensation of headword</td>
</tr>
<tr>
<td>Ninst</td>
<td>Instrument noun</td>
<td>Sound</td>
<td>Sound uttered</td>
</tr>
<tr>
<td>Nben</td>
<td>Benefactee</td>
<td>Cpart</td>
<td>Counterpart, complement</td>
</tr>
<tr>
<td>Ngoal</td>
<td>Noun of goal</td>
<td>Ant</td>
<td>Antonym: Opposite</td>
</tr>
<tr>
<td>Ndev</td>
<td>Deverbal noun</td>
<td>Head</td>
<td>Head of group</td>
</tr>
<tr>
<td>Res</td>
<td>Result</td>
<td>Group</td>
<td>Group: collective</td>
</tr>
<tr>
<td>Whole</td>
<td>Noun of the whole</td>
<td>Unit</td>
<td>Single unit of headword</td>
</tr>
<tr>
<td>Part</td>
<td>Part of the whole</td>
<td>ParS</td>
<td>Parallelism (same)</td>
</tr>
<tr>
<td>Mat</td>
<td>Material</td>
<td>ParS</td>
<td>Parallelism (same)</td>
</tr>
<tr>
<td>Vwhole</td>
<td>Verb of the whole</td>
<td>Idiom</td>
<td>Conventionalized expressions</td>
</tr>
<tr>
<td>Serial</td>
<td>Conventionalised serial</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>constructions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.4. I have homonyms in my database. When Lexique Pro creates hyperlinks from other entries, how does it decide which of the homonyms to link to?

Suppose you have two entries for the same word 'biki' as follows:

```
lx biki
hm 1
ps n
g e bicycle
```

```
lx biki
hm 2
ps n
g e cookie ; biscuit
```

Suppose you want to link to one of these entries from another entry, e.g. a synonym link (`sy`):

```
lx kuki
ps n
g e cookie ; biscuit
sy biki
```

When Lexique Pro creates a link, which 'biki' will it link to? Unfortunately, it will choose the first entry it finds. But we want it to link to the second 'biki'. So how can we force Lexique Pro to do this?

What we need to do is put a number '2' in the `sy` field, so that Lexique Pro knows it should link to the second homonym, e.g.

```
lx kuki
ps n
ge cookie ; biscuit
sy biki2
```

Note that leaving a space before the number 2 also works:

```
lx kuki
ps n
ge cookie ; biscuit
sy biki 2
```

The '2' does not get displayed on the screen but Lexique Pro uses it behind the scenes to make sure your links are as you want them to be.

5.5. I have a couple of words which are homonyms. How can I put a link in each of these entries to go to the other homonym?

Suppose you have a couple of homonyms, meaning 'whiteman' and 'spider':

```
lx vé'ho'e
hm 1
```

To display links from one to the other, use the LF (Lexical Function) field, specifying "Hom" (homonym). Include the number '1' at the end to make Lexique Pro jump to the first homonym, or '2' at the end to jump to the second homonym. You can also include a LF field giving a gloss. So, for homonyms to display and be clickable, the entries for 'whiteman' and spider' would look like this:

```
\lx vé'ho'e
hm 1
ps na
ge whiteman
lf Hom = vé'ho'e2
le spider

\lx vé'ho'e
hm 2
ps na
ge spider
lf Hom = vé'ho'e1
le whiteman
```

5.6. The setup program I generate for my lexicon with the Distribution wizard: can I give this freely to anyone?

Yes, you can, as long as you are the owner of the data or have permission to distribute the data in this way.

Please do not distribute any of the Lexique Pro program files separately. They must be packaged in the setup program with your data, as created by the Distribution Wizard.

Please ensure that people know how to contact you for support. Since Lexique Pro is a freeware product, we are not able to provide support for everybody you give your data to.

5.7. Can I put the distributable setup program on my website for people to download?

Yes, you can, as long as you are the owner of the data or have permission to distribute the data in this way.

Please ensure that people know how to contact you for support. Since Lexique Pro is a freeware product, we are not able to provide support for everybody you give your data to.
5.8. How can I get Lexique Pro to play my sound files?

Lexique Pro can play .wav and .mp3 audio files.

**Pronunciation of lexical entry**

To specify a filename for the pronunciation of the main lexical entry, use the \sf marker. (This can be changed in the Field Markers page of the Configure Lexicon wizard).

Examples:

\sf c:\my sounds\abc.wav  [using full path]
\sf def.wav  [same directory as database]
\sf sounds\ghi.wav  [relative to database directory]

This sound file should contain the pronunciation of the lexical entry. It is played when you click on 'Pronounce'.

**Sound file for corresponding example, paradigm or lexical function**

To specify a filename for a context-based sound, use the \sfx marker. (This can be changed in the Field Markers page of the Configure Lexicon wizard).

You can associate sound files with examples, e.g.

\xv Je vais au marché.
\xe I am going to the market.
\sfx c:\my-sounds\market.mp3

...and paradigms, e.g.

\pl oxen
\sfx c:\my-sounds\oxen.wav

...and lexical functions, e.g.

\lf Ant = heavy
\sfx c:\my-sounds\heavy.mp3

5.9. My .pcx images are not displayed. Why is this?

Only JPG, BMP, GIF and PNG image types are supported. It is like an HTML viewer. You'll need to convert your PCXs to one of these other formats. It is probably best to avoid .bmp, since the files tend to be bigger, especially if you want to distribute the lexicon.

There's no need to remove the PCX info. Just add another field, e.g.

\pc .G.images\flower32.pcx;1.5";0.72";PCX
Tell Lexique Pro that it should look at \pc2 for the image file name (in the "Field Markers" page of the Configure Lexicon wizard).

5.10. How can I include video files in a lexical entry?

Provided you have a video player installed (e.g. QuickTime Player or Windows Media Player), you can put a link into a lexical entry to play a video clip. Recognised types are: AVI and MOV. (If you need access to other file types please let us know.)

In Shoebox/Toolbox, define the following new fields:

- \ff - Attached file: filename
- \fv - Attached file: caption (vernacular)
- \fe - Attached file: caption (English)
- \fn - Attached file: caption (National)

Here is an example:

\ff c:\my videos\house-building.avi
\fv So jòli
\fe House building
\fn Construction d'une maison

You do not have to include all the captions: \fv, \fe, \fn are optional, but you should have at least one.

5.11. How can I include links to Word or PDF documents in a lexical entry?

You can put a link into a lexical entry to display a .doc or .pdf file.

In Shoebox/Toolbox, define the following new fields:

- \ff - Attached file: filename
- \fv - Attached file: caption (vernacular)
- \fe - Attached file: caption (English)
- \fn - Attached file: caption (National)

Here is an example:

\ff c:\my documents\marriage-traditions.doc
\fv Furusiri laadaw
\fe Marriage traditions
\fn Traditions de mariage

You do not have to include all the captions: \fv, \fe, \fn are optional, but you should have at least one.
5.12. Are there Linux or Mac versions of Lexique Pro?

Lexique Pro is a Windows program. Sorry, there are no plans to develop versions for Linux or Mac OS.

The web page export from Lexique Pro, however, can be viewed with Linux and Mac browsers. In the future, the hope is to enhance this export further to include sounds, pictures, etc.

For other details of features, downloads and frequently asked questions, see:

www.lexiquepro.com